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FrontlineSMS Help

In the FrontlineSMS application, Help is available through the main Help menu along the top of the FrontlineSMS screen. Specific help is also available on each
individual FrontlineSMS module by clicking on the ® icon on the relevant screen.

Getting started

Introduction to FrontlineSMS

Watch a shortintroductory video on the FrontineSMS website [requires the Internet]

Download the FrontlineSMS/Ashoka Changemakers "Quick Start" SMS Guide (PDF, 1Mb) [requires the Internet]

The menus

The "File" menu explained
The "Settings" menu explained

The "View" menu explained

The tabs

How to use Home
How to use Contacts
How to use Keywords
o Auto Reply Settings
o Auto Forward Settings
o Join/Leave Group Settings
o E-mail Settings
o External Command Settings
How to use Messages
How to use E-mails
How to use Phones
How to use HTTP Trigger
How to use Forms
How to use Translation Manager

How to use Reminders

Getting help
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About Internet Services
About MMS
Troubleshooting

FrontlineSMS Community [requires the Internet]

kiwanja.net 2005-2010
Last edited: August, 2010
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Background

FrontlineSMS was the first text messaging system to be conceived, designed and written firmly with the needs of the non-profit sector in mind. Until its release in
2005, the majority of systems did not taken into account the nature of non-profit work, and the specific conditions (financial and physical) which many NGOs work
under. The FrontlineSMS software is provided free to charities and other non-profit organisations. FrontlineSMS has been successfully deployed in over fifty
countries in many areas by grassroots NGOs including the Nigerian and Philippine elections, in the sending of security alerts to fieldworkers in Afghanistan, market
prices to smallholder farmers in Aceh, El Salvador and Cambodia, and to circumvent government restrictions in countries including Zimbabwe and Pakistan. You can
hear directly from a growing number of FrontlineSMS users through our Guest Blog and online Community

So, what is FrontlineSMS? Well, FrontlineSMS tumns a laptop - or desktop - computer and a mobile phone or modem into a two-way group messaging hub (see
image, above). Since it works anywhere there's a mobile signal, it doesn't need the Internet, a major advantage for many grassroots NGOs. Once you have the
software running on your computer, you can send messages to wide groups of people, and collect responses to any questions or surveys you might want to run, all
via text message

The FrontlineSMS success story has been cited in numerous NGO and industry research papers, websites, news sites and publications since its launch in 2005. It
was short listed in the Mobile Messaging Awards 2007, named WSIS "ICT Success Story of the Month" for its use in monitoring the Nigerian elections, was a finalist
in the Stockholm Challenge 2008 and won a prestigious Silicon Valley "Tech Award" in 2009

In the first four years since its release, FrontlineSMS has been used by NGOs for a wide range of activities including blood donor recruitment and assisting human
rights workers, to promoting government accountability, keeping medical students informed about education options, providing security alerts to field workers,
election monitoring, the capture and exchange of vegetable (and coffee) price information, the distribution of weather forecasts, the co-ordination of healthcare
workers, the organising of political demonstrations, the carrying out of surveys and the reporting and monitoring of disease outbreaks. The uses are endless

What can FrontlineSMS do for me?

Are you a locally- or internationally-based NGO looking at the potential to use mobile phone text messages to reach specific groups of individuals within a target
community? Or to run an awareness raising campaign? Or to run a competition, or carry out a text-based survey? Or to simply keep in touch with your fieldworkers
or staff?

If you have already identified applications for text messaging within your organisation and are looking for a simple, comprehensive, affordable and complete entry-level
system then you're in the right place. If you think text messaging could work for you but don't know where to start, and are looking to try a senice without having to
dig too deep into your pockets, then you're also in the right place

FrontlineSMS is the complete text messaging solution for the non-profit sector:
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Create and manage all of your SMS-related contact groups

Send and receive messages Via special on-screen consoles

Provides incoming and outgoing message history for each contact

Engage with your contact groups - run surveys, competitions etc. via the SurveyManager
Run your own text-based information senice via the automated ReplyManager

Export data to Excel and other programs

No need to be on-line - works on any GSM network via your own PC or laptop

® © o o o o o

Who is behind FrontlineSMS?

The FrontlineSMS concept was dewveloped by kiwanja.net in early 2005, and the first version released later in the same year. Since 2003, kiwanja.net has been
helping local, national and international non-profit organisations make better use of information and communications technology in their work. Specialising in the
application of mobile technology, it provides a wide range of ICT-related senices drawing on over 25 years experience of its founder, Ken Banks

The initial rebuild of FrontlineSMS was kindly funded by the MacArthur Foundation in 2007 and the Hewlett Foundation in 2009. The Open Society Institute and HIVOS
provided follow-on funding during the open sourcing phase, and to help us build and grow the user community. In 2010, the Rockefeller Foundation and the Omidyar
Network came on board and provided further development funding. Programming and software development has been carried out by Alex and Morgan at FrontlineSMS
HQ, with earlier support from Ben, Kadu and Tom at Masabi. The FrontlineSMS website was crafted by a team lead by Margaret and Marcelino - ably directed by
Renny - at Wieden+Kennedy

Finally, a big thanks to you - the users - for helping make the FrontlineSMS story a success! \o/

Remember to keep us posted on your progress, and don't forget to join and share your stories with the growing online FrontineSMS Community

Return to Help main menu
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The File menu

The File menu allows you to import and export your data into and out of FrontlineSMS, and quit the program

m FrontlineSMS
File

&Expor’c... 4
Cgimport.. ¥

] Exit

Exporting your FrontlineSMS data into other programs

FrontlineSMS allows you to export all of your Contact information, incoming and outgoing message data, and Keyword information to separate comma separated
files (CSV) for importing into other programs such as Open Office or Microsoft Office. To export your data, select Export from the menu, select what you want to
export, and follow the on-screen prompts.

Importing data from other applications

If you have a large number of Contacts and mobile numbers in other applications that you want to add to FrontlineSMS, you can do this through the Import menu
option. Import will read any comma separated file (CSV). The file needs to be laid out based on the fields you plan to import. To import all fields, the file needs to
contain:

<Contact name>, <Mobile number>, <Other mobile number>, <Email address>, <Current status>, <Notes>, <Groups>
Refer to the application user guide if you don't know how to export your data into a CSV file.
NOTE: <Current status> refers to the contact being active or dormant, and <Groups> refers to the contact groups the person needs to be a member of.

TIP: From FrontlineSMS 1.6.15, the new importing tool automatically creates your groups hierarchy, and puts newly imported contacts into these groups!

Exit
Quits FrontlineSMS. All processing and checking/receiving of messages will stop until you re-start the program.

Return to Help main menu
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The Settings menu

The Settings menu allows you to select database options, replace the "Home" tab main image, select your MMS options, configure your Intemet services and
change screen languages.

® FrontlineSMs

Seﬂings|

.~ Database Settings

mHome Tab Logo Settings

2| E-mail Settings

[ MMS Settings

() SMS Intzrnet Sevice Settings
@ Language 3

Database Settings

Only under very unusual circumstances should you need to go into the Database Settings menu (for example, to rename the database if you're running two copies
of FrontlineSMS on the same machine). It is recommended that only system administrators make any changes to the database.

Home Tab Logo Settings

If you want to customise the "Home" screen in FrontlineSMS to display your own logo or organisation name, you can replace the main "\o/" image with one of your
own, or removwe it altogether. When you start FrontlineSMS for the first time, there is no image displayed. To display the default "\o/" logo, select "Use default".

NOTE: Because of the smaller screen sizes on some of the lower-cost netbooks and laptops, you may need to remove the image altogether in order to see the
whole screen.

E-mail Settings

FrontlineSMS is able to turn incoming text messages into emails (see the 'Email' Keyword Action on the Keywords help page). In order for FrontlineSMS to do this, it
needs access to a registered email account. This is set up in the Email Settings screen (you may have to refer to your email provider to obtain the necessary
settings).

MMS Settings

From version 1.6.15, FrontlineSMS comes with a new Multimedia Messages (MMS) compatibility. For now, you can receive MMS sent to an e-mail address (MMS
sent to the connected device is not supported yet). To do so, just configure your e-mail accounts, and the fetching frequency (see below), and FrontlineSMS will look
for MMS in your inbox.

Read more about MMS on the Multimedia Messages help page.
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=4 MMS Settings [x]
MMS e-mail accounts
|.§| Account Senver |Lg'i].l\::ount E-mail

New E-:Iit

General settings
FPolling frequency (seconds)

NOTE: Every carrier formats MMS email content differently, so although MMS from most networks should work without trouble, some may not. If you are finding
messages are not processed, or contain incorrect information, please forward the offending emails to us and we will endeavour to add support in the next release.

SMS Internet Service Settings

Although FrontlineSMS was originally developed to allow group text messaging in places where there wasn't internet access, more recent versions allow messages
to be sent through the internet if and when it is available. Messages sent this way are generally much faster and cheaper than sending through an attached mobile
phone or modem, but you do need to set up an account and buy messages up-front using a credit card. Check the Internet Services help page to learn more about
Internet Services in FrontlineSMS.

Language
FrontlineSMS currently comes with language support for English, Arabic, Azerbaijani, Bengali, German, Spanish, Finnish, French, Hindi, Indonesian, Khmer,

Portuguese, Russian, Swahili and Chinese. Selecting one of these languages from the Language menu will turn all menu's and screen messages from the default
English into the chosen language.

TIP: Languages such as Chinese will only display correctly if your computer supports the additional character sets required. If the typeface displays as square
blocks on the screen then your computer does not have the correct font. Refer to your Windows user manual for details.

Return to Help main menu
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The View menu

The View menu allows you to configure which tabs you see on your screen

B FrontlineSMs

v BliHome

_2Keywords

| = E-mails

[ ] & Translation (Beta)
:‘.Reminders Plugin (Beta)
[ ] ESHTTP Trigger
DForms

The View menu allows you to select which tabs you see along the top of your screen. If, for example, you don't want to see the Forms tab (if you don't intend using
this function), you can hide it by removing the tick on the "Forms" entry in the menu. Tabs can be displayed or hidden as you see fit, and as many times as you
like, whenever you like.

Return to Help main menu
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Home

Home is your dashboard and allows you an ‘at-a-glance’ view of your FrontlineSMS system and access to "Quick Send" functionality
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What features are available on the Home screen?

Language support

The current version of FrontlineSMS comes with on-screen language support for English, Arabic, Azerbaijani, Bengali, German, Spanish, Finnish, French, Hindi,
Indonesian, Khmer, Portuguese, Russian, Swahili and Chinese. You can change the language of your FrontlineSMS installation by clicking on the relevant country
flag in Switch language [1], or via the Settings — Language menu. Languages which use specialist scripts, such as Chinese, will only display correctly if your
computer supports the additional character sets required, else they will show as square blocks. Refer to your Windows user manual for details on how to get
additional language support if you need it

Quick-send SMS

Messages can be quickly sent to individuals ("One-off messages") through the Send SMS portion of the screen [2]. Send SMS will be automatically sent via a
Clickatell or IntelliSMS account, if you have one and you are connected to the internet (Clickatell or IntelliSMS sending is quicker and cheaper). If you do not have a
Clickatell or IntelliSMS account, or your account fails for some reason, FrontlineSMS will use the first available phone in the Phones tab if you have any attached
NOTE: If you want more control over how your messages are sent, send them through the Contacts tab

Viewing FrontlineSMS activity

You can get an oveniew of what's happening in FrontlineSMS in the Latest Events window [3]. Events which appear in this window include lists of incoming and

outgoing text messages, outgoing FrontlineSMS-triggered emails, failed messages and connected/disconnected phones. The events window can be cleared by
clicking the Clear button [4]

Return to Help main menu
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Contacts

Contacts is your mobile address book where you create folders, Groups and add and edit details of people you are keeping in touch with

File SeMings View Help

B 8o ] oI e

A Groups & Contacts
[ B Al Gontacts [ | | 4 search
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What is a Group?

As you do with the documents and folders on your computer, FrontlineSMS allows you to file your contacts into different Groups of your own choosing, making them
easier to maintain, manage and select when you want to send text messages. Contacts can be grouped in any way you like (for example, by topic or geographic
location, or project), and Groups can be made inside other groups. For example, you may decide to create a Group for a village, and then inside that Group have
separate Groups for doctors, nurses and midwives who live or work in that village. Grouping them this way means that you can send specific text messages to all
the doctors, nurses or midwives working in that village

When you start FrontlineSMS for the first time, it only has one entry in the Groups window [1]

Creating a new Group

To create a new 'top level' Group (in the example above, this would be the name of the village), highlight All Contacts in the Groups window [1] on the left. Click on
the New Group button [2] and type in the name for your new Group. Your new Group will appear in the Groups window. You can have as many 'top level' Groups as
you like - just remember to create these under the All Contacts Group. To create 'sub-groups' (in the example above, these would be Doctors, Nurses and Midwives)
simply highlight the 'top level' Group you want to create this new Group under (in this example, that would be the name of the village) and, as before, click on the
New Group button [2] and enter the name of the 'sub-group'

Deleting a Group

If you no longer need a Group for some reason, you can remowe it by highlighting it in the Groups window [1] and clicking the Delete button [3]. If there are contacts
within the Group, FrontlineSMS will ask if you want to keep these contacts, or also remove them. If you choose to keep them, they will be moved into the All
Contacts Group (you can then move them into other Groups - see the "Editing a Contact" section below)
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Adding new Contacts to a Group

Once your Group is created, you can add new members into the Group. To do this, select the name of the Group you want to add members to from Groups window
[1] on the left and then click on the New Contact [4] button. You will be presented with a new window, below:

& Contaci Detalls ®
o | e ]

5| Mobile Number

 other Mobile Number |

I E-mail Addrass

& Current Status » Active () Dormant
| Notes
4 Groups

| Add to Group... g Remove From Group

o | ¥ cancel

Enter the details for your new Contact, and then click Save. The only information that you must enter is a name and mobile number - the rest is optional. Selecting
Active or Dormant determines whether or not the Contact will be included when you send messages to the whole Group. This feature is useful if someone is
travelling and does not want to receive messages while they are away, or if someone has temporarily left the Group

Editing and Deleting a Contact

Once Contacts have been created, you can edit any of their details to reflect any change of name, number or email address, or if they become Active or Dormant.
To edit a Contact, highlight them in the Contacts window [7] and then click on Edit [5] to make changes. You make edits in the same window as you used to add
the Contact originally (see above). If you want to delete the selected Contact, click Delete [6] with the Contact highlighted instead

Viewing a Contact's message history

FrontlineSMS maintains a comprehensive history of all messages sent to each of your Contacts, and any messages they send to you. To view the message history
for any Contact, select the Group they belong to in the Groups window [1] then look for them from the Contacts window [7]. Right-click on their entry and select
Message History from the menu

Sending a Group text message

Once your Group is created and you have added your Contacts, you can send a text message to every 'Active’ member of that Group. To send a message, select
the Group you want to send the message to in the Groups window [1] and click Send SMS [10]. In the Compose New Message window that appears, type your
message and hit the Send button. That's it

Sending an individual (single) text message

To send a single text message to just one Contact, select the Group that person is a member of in the Groups window [1] and then select them from the Contacts
window [7]. Now click Send SMS [9]. In the Compose New Message window that appears, type your message and hit the Send button

Calculating the cost of sending your messages

FrontlineSMS can help you estimate the cost of sending out messages to your Groups before you send them. This can be useful if you are running to a budget, or
using a pre-pay SIM card in the phone and want to verify that you have enough credit before you begin. Using the Cost Estimator (see bottom right of the screen)
enter what you pay on your mobile plan per message in the ISMS field. Now, when you start typing a message you want to send, FrontlineSMS will tell you how
much credit you need to send your message to all 'Active' members of the Group. You can then decide whether to proceed or not

TIP: At the moment, FrontlineSMS cannot automatically check your airtime balance. To do this you will need to make a balance enquiry on the phone itself, as per
the instructions provided by your network operator

Return to Help main menu
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Keywords

Keywords is where you create Autoreplies, manage SMS-to-email settings and configure FrontlineSMS advanced features
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KeywordManager
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What can | do in Keywords?

Keywords is an extremely powerful module which allows you to automatically trigger actions within FrontlineSMS. This section of FrontlineSMS Help will guide you
through the features in the Keywords module. Please take your time - there's a lot here.

Keyword actions

Keywords are simply predefined words which, when users or members of the public text them in, cause FrontlineSMS to carry out a specific action. This action can
be one of seweral things (click on a type for more info):

e Auto Reply
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o FrontlineSMS will automatically send a pre-determined SMS back to the sender of the keyword/message (maybe a "Thank you for your message", for
example)
e Auto Forward
o FrontlineSMS will automatically forward the incoming message to all members of a pre-determined Group. This can be useful when you want Group
members to be able to contact each other via SMS with latest news, or urgent announcements. (Auto Forward does a similar thing to Twitter, which
you may have heard of).
e Join Group
o FrontlineSMS will automatically add the person who sent the SMS to a pre-determined Group. Again, this is useful if you are running a series of user
Groups or clubs, and want people to be able to join automatically by publicising the keyword without them having to contact you directly. A campaign,
for example, could say "To join our Control Arms Campaign, text in the word JOIN to 650123456". Here, JOIN is the keyword.
e Leave Group
o Members of Groups can leave any time they like by sending an SMS with a pre-determined keyword or phrase (for example, LEAVE GROUP)
e E-mail
o Keywords can be used to instruct FrontlineSMS to automatically forward an incoming text message to a pre-determined recipient, by email. This might
be useful if you want a Project Manager, or someone in a different country or office, to receive (free) email notifications of incoming Survey or campaign
text messages, or if you'd like some of your text messages to be backed up in an email system such as Google Mail or Hotmail.
e External Command
o Although a particularly advanced feature, and one most likely to be used by more technical users, keywords can be set up to trigger the running of
external commands or programs (for example, a batch file or a script). For example, a batch file could be written which finds out how much free disk
space is left on the computer. An incoming SMS with, say, the keywords FREE SPACE could then be set to trigger the running of this batch file, with
FrontlineSMS texting the result (i.e. the amount of free disk space) back to the message sender. The External Command function can also be used
to instruct FrontlineSMS to send incoming messages to remote servers over the internet (using HTTP GET), which may be useful as a method of
backing up data, or for a website with a news ticker which needs to display all incoming messages for a campaign or event

Keywords can also be set to have multiple actions. So, for example, the Keyword JOIN could be set to allow people to remotely Join Groups, and to also do an
Auto Reply to the message sender with a "Thank you for joining our Group. We will be in touch" message. If you really wanted to, you could also set the JOIN

Keyword to Auto Forward the joining message to all other members of the Group, in case you wanted them all to know that there was a new member. There is no
limit to the number of actions that can be set for a Keyword.

Using the <None> and <MMS> keywords

When you start FrontlineSMS for the first time, you will notice two entries - <None> and <MMS> - in the main Keyword window [1]. If you want every incoming
SMS which doesn't match any other keyword to trigger an action - perhaps a thank you message - regardless of message content, then use the <None> keyword
entry. You can use <None> to forward every incoming message to a website, or to senices such as Twitter or Facebook, for example. If you would like to trigger
actions everytime a Multimedia Message is received, use the <MMS> keyword.

NOTE: For Multimedia messages, the date taken into account for keyword actions is the actual date of reception, and not the date FrontlineSMS picked the
message.

Adding a new Keyword

All current FrontlineSMS keywords appear in the main Keyword window [1]. To add a new Keyword, click on New[5] and enter a name (and a description, if you
need one - this is not essential). Your keyword will then appear in the main window [1]. After highlighting the new keyword you can edit any of the fields to the right
[2]. See below for the various options.

Adding actions in the "Simple View"

Adding an "Auto Reply" action

If you want an automatic message to be sent back to the message sender (perhaps a "Thank you for contacting us" message, or similar), tick the check box and
type this message in the "Send this message as an auto reply" field [2].

Adding a "Join Group" action

If you want this keyword to automatically instruct FrontlineSMS to add the sender of the message to a specific Group, select the Group name from the list under
"Add message sender to group" [2].

Adding a "Leave Group" action

If you want this keyword to automatically instruct FrontlineSMS to remove the sender of the message from a specific Group, select the Group name from the list
under "Remove message sender from group" [2]. When you are finished adding these initial actions, click the Save button [3].

NOTE: When testing your keywords for the first time, bear in mind that it can take a couple of minutes for FrontlineSMS to pick up the incoming text message, and
a minute or two for the event to be triggered.

NOTE: There are other Advanced keyword actions that can be set. See the section below for further details.
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Adding further actions in the "Advanced View"

If you'd like to add further actions to any of your Keywords, selecting the Keyword from the Keyword window [1] brings up an additional menu function. [4]. Click on
"Click here to go to advanced view" to open up a new screen (below).

M

lia Sttnga iew, Dabug, tislh

lmuuml & cmml 30 Kopworas @mum;l@mml _l_ Phones|
&) Kayword Actions
[ scton

KeywordVanager

=i i
@m Forward

E Join Group

&%Lesn Group
[ emai ’
Fage o1 | 4= [cp | | [l Extemal command
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Keyword was saved successiully . Cost astimator. £ 15M8

This "advanced view" allows you to add additional actions to your Keyword. A list of available actions are listed in the pop-up menu [1]. Select the new action which
you'd like to add, and then click on the settings button [2] A different dialogue box will appear next, depending on which action you select.

Auto Reply

Auto Forward

Join Group

Leave Group
E-mail

External Command

® O o o o o

Return to Help main menu
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FRONTLINESMS

Auto Reply settings

2% Auto Reply [x]

Remaining characters: 0 0

Click ta include: ' Estimated cost. £0.00
Start Date End Date

| « Save || € cancel |

The Auto Reply screen allows you to add or edit the automated message being sent back in return, to include the Sender's Name in the message (if their number is
recognised by Contacts), and to set Start and End Dates if you only want the Auto Reply to run for a set time.

Return to Keywords

Return to Help main menu
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Auto Forward settings
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The Auto Forward screen allows you to add or edit the automated message being forwarded to the specified Group, to include the Senders Name in the message
(if their number is recognised by Contacts), and/or to include the body of the original message. This feature is useful if Group members are sending messages to
other Group members. For example, here the Forwarded Message could read "From: ${sender_name}. Message: ${message_content}". You can also set Start
and End Dates if you only want the Auto Forward to run for a set time.

Return to Keywords

Return to Help main menu
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Join/Leave Group settings

5 JoiniLeave Group [x]
Keyword auto-join Group

| « Save || 2 Cancel |

The Join Group and Leave Group screens allow you to instruct FrontlineSMS to add people sending in the chosen Keyword to a pre-determined Group, or to
remove them from that Group. Start and End Dates can also be set if you only want the action to run for a set time.

Return to Keywords

Return to Help main menu
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E-mail settings
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NOTE: You need to set up an email account in FrontlineSMS if you want to use this function. Click on "E-mail Accounts Settings" and enter the name of your
SMTP server, your full email address and your email password. You should have these settings - if not refer to your email provider. You may also want to create a
unique email address for FrontlineSMS to use. Successfully added email accounts display in the 'From' window

The E-mail screen allows you to tell FrontlineSMS to automatically forward incoming text messages starting with your pre-determined keyword to an email recipient.
On the E-mail screen, type in the Subject for the email, followed by an email Message you can include fields such as Senders Name and the Message Content
within the body of the email message - if you like - by clicking on the relevant Click to include button). Select the email account you want to send the messages

through in the From window, and the email address of the person you want the emails to be sent to. Again, you can set Start and End Dates if you only want the
emails to be sent during a set time period.

Return to Keywords

Return to Help main menu
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External Command settings
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The External Command screen is where you tell FrontlineSMS to run another program on your computer, execute a set of commands, or send incoming
messages over the internet to a web server whenever a text message containing a pre-determined Keyword is received. Please note that this is advanced
functionality and you will likely need technical skills to make any use of it.

e HTTP Request

o If you have an internet connection, FrontlineSMS can automatically send incoming messages over the internet to a web server (this is the functionality
used by many Ushahidi deployments). This can be useful in a number of ways. For example, it can be helpful if you want to back-up messages off-site
in case of data loss. Or, if you're running a campaign and want to display SMS feedback from supporters on the homepage of your website,
FrontlineSMS can 'pass' this information on (although your web developer will need to write a script to 'listen out' for incoming messages). The
messages could then be displayed as a scrolling 'ticker'.

o To set up a HTTP Request, select the option at the top of the screen. Along the Command line, enter the URL (website address) for the server you
want to pass incoming messages to. Depending on how you configure the 'listening' server, you can attach certain bits of information to the end of the
Command by clicking on any of the Click to include buttons, which adds the relevant field names in for you. Once a message has been successfully
received by the server, you will most likely get a response confirming its arrival. Again, depending on your remote server, the Response Type will most
likely be Plain Text. You can decide whether or not you want to do anything further (if not, select Do Not Wait For Response) but you can, if you
like, send a reply back to the original message sender (or an entire Group), notifying them that their message has been successfully posted to your
website, or successfully received. To do this, type your auto-reply message in the Message window and then, if you also decide to send this message
to an entire Group, select the Group name from the list in window under the Forward to Group tick box.

o Finally, you can set Start and End Dates if you only want the HTTP Request to be active during a set time period

o TIP: You can also insert the response text that you get back from the remote server by clicking the Include Response button while compiling your
message

e Command Line Execution
o Software developers and advanced users can write batch files or scripts, and then instruct FrontlineSMS to run them when the pre-determined keyword
is detected.
o These scripts can be programmed to do pretty-much anything, depending on the programmer. To run an external command, follow the instructions
above, selecting Command Line Execution from the top menu.
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Return to Keywords

Return to Help main menu
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Messages

Messages allows you to view your incoming and outgoing message history by individual Contact, by Group, or by individual Keyword
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Viewing message history

FrontlineSMS allows you to view all your incoming and outgoing messages in a number of ways:
By Contact

Clicking on the Contacts button [1] brings up a list of all your FrontlineSMS Contacts, regardless of Group. Your full Contact list will appear in the window below [4].
Selecting a Contact from this list will display their full message history in the adjacent window on the right [5]. You can filter these messages (for example, only
show Sent or Received messages) but ticking and/or unticking the Received and Sent boxes [2]. If you also want to filter the messages by date, you can select a
From and To date range [3]

By Group
Clicking on the Groups button [1] brings up a list of all your FrontlineSMS Groups in the window below [4]. Selecting a Group from this list will display a full Group

message history in the adjacent window on the right [5]. You can filter these messages (for example, only show Sent or Received messages) but ticking and/or
unticking the Received and Sent boxes [2]. If you also want to filter the messages by date, you can select a From and To date range [3]

By Keyword

Clicking on the Keywords button [1] brings up a list of all your FrontlineSMS Keywords in the window below [4]. Selecting a Keyword from this list will display a full
Keyword message history in the adjacent window on the right [5]. You can filter these messages (for example, only show Sent or Received messages) but ticking
and/or unticking the Received and Sent boxes [2]. If you also want to filter the messages by date, you can select a From and To date range [3]

Message icons
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Incoming and outgoing messages are displayed with relevant icons next to the message (indicating messages in, and messages out). If messages have been sent
and received via FrontlineSMS Forms then the following icons will display - for sent forms, and for received forms (i.e. completed information coming back
in from your contacts or users)

Return to Help main menu
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Emails

Emails allows you to view email messages automatically sent by FrontlineSMS which were triggered by incoming text messages
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Why would | want FrontlineSMS to send emails?

If you're running a global campaign and you want mobile phone owners to text in their address so you can send out information packs, or you're asking them to 'sign’
a petition, you may want to send this information on to your head office or forward it on to an administrator who works in another office. You could forward the
messages as new text messages, but these will incur additional costs, and in some cases international SMS rates. A quicker and cheaper way would be to have
the incoming text message converted to an email, and then for FrontlineSMS to send the message over the internet for you to a recipient of your choice. Details on
how to set up email forwarding are covered in the Keywords help screen

Re-sending and removing emails

Any emails that have been sent by FrontlineSMS are listed on the email screen [1]. If the computer is not connected to the internet, the messages will be held until

a connection is made, at which point FrontlineSMS will begin sending automatically. If you want to manually re-send an email (perhaps it didn't arrive, or there was a
problem with the recipient's Inbox being full), highlight the email in the list and click Re-Send Selected [2]. If you'd like to remove an email from the list, highlight it

and click Delete Selected [3]

TIP: If you delete an email which has not yet been sent, it will be removed from the queue permanently and not be sent. If you select the Delete Selected [3] option
for an email which has already been sent, it will just be removed from the list on the screen

Return to Help main menu
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Phones

Phones allows you to view and configure phones or modems connected to your computer
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Connecting phones and modems to your computer

When you start FrontlineSMS, the first thing it does is scan your computer for phones or modems it can use to send or receive messages. The process can take

two or three minutes, depending on the speed of your computer and the number of devices FrontlineSMS manages to find. Once a phone is detected, FrontlineSMS
tries to connect with it and determine how fast it can communicate, what make and model it is, what mobile number is in use on the SIM card inside the phone, and
the phone's serial number. While FrontlineSMS is scanning your computer, do not plug in or disconnect any of your phones, else it may fail

Once FrontlineSMS has successfully set up your phone it will be made available for you to use, and displayed in the Working devices window [1]. If this is the first
time the phone has been used, you will be presented with a separate configuration window - see below for details of what to do with this. If FrontlineSMS is unable to
communicate properly with your phone it will appear in the Non-working devices window [2] below. If your phone appears here, or does not appear in either window,
check out the Troubleshooting page to find out why, and how you can try to Manually Connect [3] . Please note that FrontlineSMS will not work with all phones - if
you're connected to the internet check out the Requirements page on the FrontlineSMS website for further details. Note that we recommend you use a GSM modem
with FrontlineSMS - again, see the website requirements page for more

It is recommended that you connect your phones and modems to your computer before starting FrontlineSMS. If, however, you connect a new phone while
FrontlineSMS is running and it doesn't detect it, you can ask it to rescan your computer by clicking the Auto Detect Phones button [4]. In the unlikely event that
you experience problems, leave the phone connected and exit, and then re-start FrontlineSMS, and wait for it to automatically scan for you

NOTE: FrontlineSMS can work with multiple phones at the same time, so you can connect as many devices as you like

Configuring your phone

Settings for phones and modems listed in the Working devices window [1] can be changed through their "Settings" menu. To access this menu, right-click your

P U S S S SO S PP S S P ES T SUPPRE . [ SRPURFT -SSR S S SO 1T S,
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Please note: If FrontlineSMS knows that your phone is "partially working", i.e. unable to send, or unable to receive, some of the options above will be deactivated

Don't use this phone
If this phone is connected to your computer for another use, and you don't want FrontlineSMS to touch it, select Don't use this phone and click Save

Use for sending
If you want this phone to be used to send messages, tick this box

Use delivery reports
If the phone has been selected to Use for sending, tick the Use delivery reports if you want FrontlineSMS to check if messages have been successfully delivered.
(Please note: Not all network operators support delivery confirmations. Operators in the USA, for example, do not)

Use for receiving
If you want FrontlineSMS to monitor this phone and download incoming messages, tick this box

Delete messages from phone, after receiving

If the phone has been selected to Use for receiving and you'd like FrontlineSMS to leave messages on the phone once they are downloaded and read, leave this box

unticked. Tick this box if you want them removed (recommended, else your phone will quickly fill with messages and won't be able to continue receiving)

Once you have finished setting up your phone, click on Save. If you change your mind, click on Cancel. These settings can be changed at any time by returning to

the Phone module and repeating these instructions

Return to Help main menu
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HTTP Trigger

HTTP Trigger allows developers with external applications to feed messages into FrontlineSMS for processing
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What is HTTP Trigger?

FrontlineSMS is an extremely flexible messaging application, allowing incoming text messages to trigger keyword events (auto replies, group joining, emailing,
message-posting to websites, and so on). Increasing numbers of users - software developers in particular - have been trying to integrate their own applications (which
generate patient reminders, medical advice, weather forecasts, and so on). HTTP Trigger allows these external programs to pass text to FrontlineSMS, which is then
sent out as a text message. Please bear in mind that this is an advanced feature of FrontlineSMS, and is generally reserved for experienced software developers.

How to set up a Trigger

The HTTP Trigger function is designed to allow the passing of HTTP commands to FrontlineSMS by using a mutually configured blank HTTP port. Currently
FrontlineSMS only supports the sending of SMS although this may change in the future. To set up HTTP Trigger, choose a free port number and enter it into the Port
field [2]. Click on the Start button to begin monitoring the port. All events will be displayed in the main window [1].
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NOTE: From version 1.6.16, you can ask FrontlineSMS to start listening automatically on the specified port when the software is launched by enabling the [3]
checkbox.

3rd party software FrontlineSMS

: o -
| B | | |
LS i |

Checks for updates

\o/

HTTP Trigger

This diagram gives an example of an application checking for website updates (e.g. an RSS feed). When the application detects that a new feed has occurred, it

uses a HTTP request to communicate with FrontlineSMS in the following format:

http://localhost:<portNumber>/send/sms/<destinationPhoneNumber>/<messageContent>/

Where <portNumber> is the free port, <destinationPhoneNumber> is the number to send the message to, and <messageContent> is the content of the message
All values should be URL-encoded.

Return to Help main menu
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Forms

Forms allows you to create electronic versions of simple data collection forms for use on Java-enabled mobile phones
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NOTE: To use FrontlineForms you must be running FrontlineSMS version 1.5.5 or above. To find out, check the top left of the screen when running FrontlineSMS.
The number that appears is the version you are running. If you need an upgrade and haven't received an email invitation to do so, get in touch via the Contact form
on the website

NOTE: FrontlineForms is the latest key addition to FrontlineSMS, introduced in March 2009, and is very much a work-in-progress. Although comprehensive testing
has been carried out, as with any new product there may be initial teething problems. If you have any comments or problems, please post them to the FrontlineSMS
Community on the internet so we can respond, and share your findings - and our solutions - with other users

What can | do in Forms?

Forms is a flexible entry-level data collection tool which combines the power of a Java-based mobile phone application with the ease of use and availability of text
messaging. Imagine you're a health clinic and you have staff travelling in different parts of the country collecting data on ilinesses, test results and the incident of
certain types of disease. At the moment this information is likely being collected on paper forms, which are then sent back to your clinic at certain time intervals, or
they simply come back when the member of staff periodically returns. This is obviously a slow and inefficient way of collecting data, and doesn't give the clinic 'real
time', up-to-date information from the field as it happens

The Forms module in FrontlineSMS allows you to create copies of very simple paper forms on your computer, which can then be sent to a Java-enabled mobile
phone through a text message. This phone can then be handed to a member of hospital staff who can then take it to the field with them and enter the information
they collect directly onto the phone (by following a trimmed-down version of the on-screen form you have created for them). Once the data input is complete, the
information collected can be sent back to FrontlineSMS as a compressed text message, giving you up-to-date and real-time information. Other systems are available
that provide data collection functionality, but many rely on data connectivity via the mobile phone network. FrontlineSMS does not, and only requires that you have a
mobile signal. If the forms are completed in an area where there is no signal they will be held in the phone until a signal is detected, after which they can be safely
sent

Please note: Although Forms is very flexible, it does require some intermediate PC knowledge. If you are new to FrontlineSMS or to computers, you may want to
connect with other users in FrontlineSMS Community on the intemet and ask for guidance before you begin. Regardless of your skill level, it is advisable to
experiment with the Forms module before using it in a real, live environment. Experimenting with the tool is all part of the process! You will also need to have a
phone which supports Java. Check out the Sending your completed form to a mobile phone section for more details

Activating the Forms module

When FrontlineSMS is installed for the first time, the Forms module is initially hidden from view. To activate the Forms module, go to the View menu, then select

Tabs, and make sure "Forms" is ticked. A new Forms tab should then appear with your other menus along the top of the screen. To hide the Forms module, go
back into the same menu and removwe the tick/check from the "Forms" entry

The Form Editor

To begin designing a new form, click on "New" [4] from the main window [1]. The following window will appear:
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Palette [9]

This is where you select which type of field you want to add to your form. A number of field types are available - for example, "Check box" will insert a tick-box on
the form, which the user can tick or un-tick, depending on the answer to a specific question. (In the sample form above, "Check boxes" can be seen next to the
Lives with family, Has transport and Supervisor fields). Text fields can be added by using the "Text field" tool (seen next to Borrower name in the sample above) and
"Text area" tool (which is a larger text area, used in the example above to enter the Borrower address). Note that not all fields may be available as we continue to
work on and improve the Forms module

Preview [10]
This is where you see a preview of your form, as you build it

Properties [11]

This is where you give each of your fields 'names' (such as Borrower name and Has Transport in the sample above). The properties window also allows you to select
maximum lengths for each of the fields, and select whether certain items (such as "Check boxes") start off ticked, or un-ticked, when the form is loaded. Different
palette tools have different properties settings

Form name [12]
Each of your forms need to be given a unique name. "Form name" is where you tell FrontlineSMS what you want to call your form

Save/Cancel [13]
Once you've finished designing your form you can Save it or, if you want to discard it, Cancel it [13]. "Saved" forms will appear under the name you chose in the
main window [1]

Building your new form

To build a new form the following four-step process needs to be followed. Firstly, click on which field type you would like to add, from the Palette [9]. Then, hold the
left-mouse button down and drag the field across into the Preview space [10] and let go. Thirdly, click on the field you have just added in [10] until it has a blue box
surrounding it (there won't be any text next to it yet). The final step is to edit the new field - you do this by editing the Value section in the Properties window [11].
Different field types have different properties that you can set, but a common one is Label, which is the name you give to the field (such as Borrower name in the
sample screen). You may need to practice editing and changing properties to get a better understanding of what they do and how they work

When you are finished, either Save it [13] or, if you want to discard it, hit Cancel [13]
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appear in this field - if they don't you need to click into the space before typing. Once you have finished typing your properties, hit the Enter/Return key on your
keyboard to tell FrontlineSMS that you have finished

Properties

Property Value

Type Text Area

TIP: You can change the order in which the fields appear in your completed form by highlighting the field in the Preview space and pressing the cursor up or down
keys on your keyboard. You can also delete them by pressing the delete key, or by dragging them with your mouse into the rubbish bin icon

Editing, deleting or copying an existing form

Forms that you have already created in FrontlineSMS appear in the main window [1]. 'Locked' forms also appear in this window (i.e. Forms that have been 'finalised'
and sent to a mobile phone, and which can no longer be changed. This is explained in more detail later). To edit or delete any unsent forms, highlight the form name
in the main window [1] and then click Edit [6] to make changes to it, or Delete [2] to remowe it

If you want to make a copy of a form, perhaps to make another which is similar (and you want to use an existing form as a starting point), highlight the form name in
the main window [1] and click on Copy [5]. A second form, with the same name, will appear in the main window [1] below the original with an additional "*" next to
the name. To edit this duplicate form, or to change its name, highlight it in the list and click Edit [6]. You can now make changes - it is advisable to also change its
name to awoid confusion with the original form, which you can do by typing a new name into the Form name [12] field before you Save [13]

Sending your completed form to a mobile phone

Once your form is complete you are ready to send it to a mobile phone. Before that you'll need to download the FrontlineSMS Forms Client onto the target phone
(this small program reads your forms and allows the user to fill them in and send the data back to you). Phones need to be Java-enabled and be allowed by your
network operator to connect to the Internet. Check your phone's user manual if you're not sure whether or not your phone has Java and/or is able to connect to the
internet (you will likely need GPRS for Internet access). Note that not all phones support Java or GPRS

If you have Internet access on your phone:

Open the phone's WAP/Web browser and take it to forms.frontlinesms.com - the optimum version of the Forms Client will then be downloaded directly onto your
phone and you'll be ready to go

If you do not have Internet access on your phone:

If your phone is Java-enabled but it doesn't have Internet access or coverage, click here to visit the manual download page (your computer will need to be connected
to the Internet for you to be able to access this page). This will provide you with a copy of the Forms Client for storing on your computer. From here you will need to
manually install it on your phone, most likely through a USB cable. To do this you will need some technical knowledge, which you are best to seek out in your local
area. For more general questions feel free to reach out to the FrontlineSMS Community on the internet

Before sending forms to your phones, you need to assign it to a Group which contains the names and numbers of the people you want to send the form to. If you try

sending the form without setting a Group, FrontlineSMS will give you a warning message. (You can create a new Group - if you need to - by following the instructions
in the Contacts module). To assign a Group, highlight the Form name in the main window [1] and then right-click your mouse and select Group from the menu that
appears. Select the Group you want to send the Form to from the list. You are now ready to send the Form, so click Send [3]

NOTE: Once a Form has been sent to a mobile phone, it will be ‘finalised" and you won't be able to edit it (FrontlineSMS needs to match the information coming in
from the mobile phone with the original form, and making changes will result in this information being misread). If you are happy that the form is complete and you
won't need to make any further changes, select Yes, else hit No

() Attention [x]

You will not be able to editthis farm again.

NOTE: Some of the more basic phones will be unable to ‘accept’ a form automatically. FrontlineSMS is able to detect these handsets, and in these cases a regular
text message will be sent to the users phone telling them that a new form is available - they will then need to manually request it using the Get New Forms option
on their phone (see next section, below)

Using the Forms client on your mobile phone

Once the Forms client is up and running on your phone, the main menu will look something like this:

FrontlineForms

file:///C:/Program Files (x86)/kiwanja.net/FrontlineSMS_1.6.16.3/help/forms.htm 4/6


file:///C:/Program%20Files%20(x86)/kiwanja.net/FrontlineSMS_1.6.16.3/help/forms.htm#finalised
http://www.frontlinesms.com/forms/
http://community.frontlinesms.com/
file:///C:/Program%20Files%20(x86)/kiwanja.net/FrontlineSMS_1.6.16.3/help/contacts.htm

6/9/13 FrontlineSMS Help :: Forms

Upload Data

\%E Get New Forms

NOTE: The first time you run the Forms program on your phone, depending on configuration and functionality, it may ask you for permission to ‘Allow application to
start automatically?' or 'Allow application to start when notified" If you select "OK" or "Yes" to this message, whenever new forms are sent to your phone, it will
automatically run (or "wake-up") FrontlineForms and process the new form. Not all phones support this feature, so if you do not see this message, ignore this step
and don't worry

Enter New Data

This is where you enter data into the forms stored on your handset. When the application is first installed there will obviously be no forms available to complete. To
add forms, you firstly need to create a form using the FrontlineSMS Form Editor. Once forms are created and sent to the handset, two things can happen when you
click the Enter New Data menu. If there is only one form on your handset it will open automatically. If there is more than one form stored on the handset, you will
see a list of available forms. Clicking on a form from the list will open that form and allow you to enter data into it

Manage Data
Once you have entered data into your forms, Manage Data allows you to edit or delete entries on each completed form, or to selectively upload completed forms to
the FrontlineSMS server

Upload Data

When you have filled in a number of forms, you can upload the data from these forms by clicking on Upload Data. This will then send all completed forms to
FrontlineSMS. If you only want to upload some of your completed forms, go to the Manage Data menu option

Get New Forms

Using this option will send an SMS message to FrontlineSMS to request any new forms. FrontlineSMS will only return forms to this handset if they have been "sent"
to this handset in FrontlineSMS. If you have set up forms in FrontlineSMS, but have not sent them to this handset, or if there are no new forms available,
FrontlineSMS will respond with a message saying "There are no new forms available for this handset"

Options
This section allows you to change settings for the application, and to see help and other information:

Settings

Settings m
Server Phone Numper

447890123456

[Save Settings

B X P revious)

Here you set up the hub phone number for your FrontlineSMS installation. This is the phone number associated with the SIM card inside the phone or modem
attached to FrontlineSMS on your computer. (On some phones you can also tweak settings for application wake-up, in which case there will be additional settings
available). You cannot use FrontlineForms unless you have a server phone number

Help
This section contains a short introduction to the application's capabilities and usage

About
Provides information on the version of FrontlineForms your handset is running

Debug

The Debug menu allows you to clear all FrontlineForms-related data from your handset. This will delete all forms, and all saved form data. Use this option with great
care: Once you have deleted the forms and completed form information, it cannot be retrieved!

Displaying data sent in via forms

Once you have finished designing a form, and your users have the Forms client loaded onto their phone, and your form has been sent to them (see above), your
users can take their phone and begin collecting data in the field, filling in the form you have created for them on their mobile phone screens. Their completed
information will come into FrontlineSMS as compressed text message, which is uncompressed and then matched with the original form, and the data extracted

The main window [1], with finalised forms - which have a E icon next to them - and the received data, looks something like this. This Results window shows the
data collected for each form as well as the "Submitter" (the number/contact that sent in the Form). Just click on any Form name to view the responses
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NOTE: Even though Forms may be finalised, you still have the option to send them to more phones. To do this, select the Form name in the Forms window [1] and
select Send [3] and follow the earlier instructions
Exporting your Forms data

You can export your Forms data into a Comma Separated (CSV) file which can then be read by a wide variety of other applications (Excel, for example). With the
Results window showing, select your Form name (or field name) and click on the Export results button at the bottom right of the screen

Export [x]
Export

[ FiIenameE §| = Browse... |

ﬂ; Export | | € Cancel

Enter a Filename for the data, and choose a location for the file using the Browse button (optional), and click Export
As previously suggested, it is recommended that you experiment with FrontlineSMS Forms and get comfortable before using them in a live environment

It is also recommended that you regularly back up - Export - your collected data to protect against computer crashes and possible data loss

Return to Help main menu
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Translation Manager

The Translation Manager allows you to help us translate FrontlineSMS into different languages.
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What can | do with the Translation Manager?

FrontlineSMS is available in an increasing number of languages, and each has been put together by teams of wolunteers. Up until now, incorporating a new language
has been difficult, and has relied on support from the core FrontlineSMS team. Translation Manager changes all that, and allows you to create your own translations
without needing to work through us. You can edit existing translations in case you find errors, or want anything changed. You can also create brand new
translations, and then send us the files so we can include them in future public releases.

How can | edit existing translations?

The Translation Manager is split into two parts. The left pane [1] displays currently available languages, the right pane [2] the various translations for the selected
language. You can either double-click on an entry, press Enter when selected, or click on the Edit button [3] at the bottom to edit it..
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English

Frangais [Toutes les raductions ]

If you change any of the translations, your new values will be displayed in bold in the list, as shown in the example below:

plugins translation translation.sent Translation sent. Thank you very much for your contribution Traduction correcternent envoyée. Mous vous remercions pour votre contribut
plugins translation_translations.all All Translations Toutes les propriétés
plugins translation.translations.extra Extra Translations Traductions en plus

When you're done editing, just press the Save button [4] at the bottom of the screen. You will need to quit and then restart FrontlineSMS to see your changes.
NOTE: Be sure to save your translation before leaving the Translation Manager screen, else all of your changes may be lost.

NOTE: You can edit several languages at the same time, and the Missing Translations tab in the list [5] helps you figure out the properties not yet translated for
the selected language.

How can | add a new translated language in FrontlineSMS?

To add a new language, just click on the New translation button [6]. Next, complete the details in the dialog box, as shown below. This forms the base information
for your new language

' Language properies IE
@ |Language name | Chichewa |
=l=Flag corresponding to the language |-Malawi v|

@150 639-1 Code for this language

|| This language requires a special font: _.

|:| Take a hase language:
& Click here for help about language properties.

| « Save || 3 cancel |

Please note:

The language name must be in the native language. If this language doesn't use Latin characters, add the English name between (brackets) at the end.
Sevweral flags may correspond to your new language, so just choose the most relevant.

The ISO 639-1 Code is the international code for a language. You can find a list of those code on this page [requires the Internet].

Some languages might require a special font or typeface. If so, insert the name of a common font which works with your language.

You can take an existing language as a base language, if your new one is based on another. This might save you some time

e e o o o

Please note that you can edit these properties at any time by right-clicking on a language, and selecting Properties from the menu.

How can | send my changes to the FrontlineSMS team?

Once you've modified a language, or added a new one, you can send us your work so we can share it with the wider community. To do so, just right-click on the
language you would like to send, and select Submit this translation from the menu. Please add the following information so we know who you are:

. Submit translation [x]

[ Submitted language: [ IFrancais

@ [Your name: | Sebastien Mitter |

@ [Your e-mail address: | sebmitter@languages.com |

| |would like to appear as a contributor for this language
| " Submit || 2 Cancel |

Thank you very much for you help! \o/

Return to Help main menu
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Reminder Manager

The Reminder Manager allows you to schedule email or SMS notifications for a single or multiple recipients with a specific start date, end date and occurrence.

"'
File Settings View Debug Help

Ao/ Home sc-antacts @K&mﬂrﬂs él\-{essages — | E-mails ! Phones @Reminﬂers (Beta)

!EJ =1 Account E-mail [john.anderson@gmail.com : smtp.gmail.com : SMTP : 465 v|
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C = Once 24/0B/2010 24/08/2010 10:30:00 John Anderson Doctor's Appointment Don't forget your dc
- =4 Hourly 23/08/2010 23/08/2010 17:00:00 Jane Smith;Sarah Bro Hourly Exercise

© = Daily 23/08/2010 4 27/08j2010 08:00:00 Sarah Brown Take Medication Don't forget to take
E E Weekdays 23/08/2010 17:30:00 29/10/2010 17:30:00 Tara Nelson Turn Off Lights

E =l Monthly 01/08/2010 09:00:00 01/12/2010 09:00:00 Jane Smith Pay Rent Don't forget to pay 1
e = Sundays 22/08/2010 14:00:00 197122010 14:00:00 Tara Nelson Call Mom Don't forget to call §
= E= Weekly 06/08/2010 18:00:00 17/12/2010 18:00:00 Sarah Brown It's the weekend!
.E B4 Tuesdays 03/08/2010 09:30:00 31/08/2010 09:30:00 Tara Nelson Yoga Class

¥

%New l ‘ ;@ _ ‘ @ ‘ [ﬁ e S neyas @

Email Reminder Created | Cost estimator: £ / SMs,

What can | do with the Reminders?

Reminders offer a powerful way to schedule email or SMS notifications to recipients with a specific date range and occurrence. Reminders can be useful for sending
a one time notification, for example for a patient on the day before their doctor's appointment. Alternatively a recurring reminder can be sent for a specific date range
and occurrence, for example a patient notication to take their medication at the same time each day for one week. All the reminders you will create will appear in the
list [1].

Account E-Mail

Before you can send an e-mail reminder, you must first specify the sending e-mail account from the Account E-mail dropdown [2].

NOTE: If the Account E-mail dropdown is empty, you'll need to first add an e-mail account via the Edit > E-mail Settings menu.

Reminder Occurrences

Reminders can be scheduled with a variety of different occurrence types:

e Once - reminder only occurring once
e Hourly - recurring on an hourly basis
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Daily - recurring on a daily basis at the same time each day
Monthly - recurring on a monthly basis

Mondays - recurring every Monday at the same time
Tuesdays - recurring every Tuesday at the same time
Wednesdays - recurring every Wednesday at the same time
Thursdays - recurring every Thursday at the same time
Fridays - recurring every Friday at the same time
Saturdays - recurring every Saturday at the same time
Sundays - recurring every Sunday at the same time

® © 0 & 0 o o 0 o o o o

Weekly - recurring every week on the same day of the week and at the same time of the day

NOTE: Once reminders only require a start date, however all other occurrence types require both a start and end date.

How do | create a reminder?

You can create a reminder by clicking the New button [3], which will display the reminder dialog.

Occurrence - the occurrence type for the reminder

Start Date - the first time the reminder will be sent

End Date - when the reminder will expire

Recipients - the recipients for the reminder

Type - how the reminder will be delivered, either E-mail or SMS
Subject - the reminder subject which is only used for E-mail
Message - the reminder message used for both E-mail and SMS

® © & o o o o

Weekdays - recurring at the same time each day for every weekday (Monday, Tuesday, Wednesday, Thursday and Friday)
Weekends - recurring at the same time each day for every weekend (Saturday, Sunday)

Once you have finished entering the reminder information, click Save button [4] to create your reminder or the Cancel button to discard your values.

File tllngs View Debug Help

Nof Create Reminder [x!
(o748 Home s C
: 2) Occurrence  [Once -
| 5 " —
Q RACRUILE I} Start Date |10 -| |43 v| |PM vl | 22/08/2010 | o
Q0 [ - saws [ = |Content
g wiEng Bak |-" "| | 0 '| M "| |—'— LR | 4" Don't forget your dc
s Hourly Exercise
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= Jane Smith 123-456-7891 jane.smith@gmail.com = N it L
()] Sarah Brown 123-444-5555 sarah.brown@gmail.com o Donlt forget o pay |
.E Tara Nelson 123-786-3432 tara.nelson@gmail.com [+] Don't forget to call !
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.E i b @ Yoga Class
@ @& Type @ =E-mail () [Message
14 = |Subject
| Message

Pagelofl[ 4

T T —

¢ Cancel

- @

1
SMS Reminder Created

How do | edit an existing reminder?

1., Cost estimator: £ fSI\-‘g

You can edit an existing reminder by first selecting the reminder from the list and then clicking Edit button. Optionally, you can double-click a reminder to bring up
the edit reminder dialog. Once you have edited the reminder, click Save button [4] to accept your changes or the Cancel button to discard your changes.
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4
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How do | delete a reminder?

- Cost estimator: £ ! Sh@

You can delete a reminder by first selecting a reminder from the list and then clicking Delete button [5]. Note, you will be prompted with a confirmation dialog before

the reminder is actually deleted.
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How do I re-send a reminder?
You can re-send a reminder by first selecting a reminder from the list and then clicking Re-Send Selected button.

Return to Help main menu
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SMS Internet Service Settings

Although FrontlineSMS was originally developed to allow group text messaging in places where there wasn't internet access, more recent versions allow messages to
be sent through the internet if and when it is available. Messages sent this way are generally much faster and cheaper than sending through an attached mobile
phone or modem, but you do need to set up an account and buy messages up-front using a credit card. FrontlineSMS currently comes with support for the Clickatell
and IntelliSMS messaging services. Both providers offer similar services, but Clickatell has a slightly more complicated set-up and sign-up procedure. Novice users
are recommended to try IntelliSMS first, although you can use both at the same time if you want to try them both. To start, click on SMS Internet Service Settings
in the Settings menu. If you have existing accounts set-up in FrontlineSMS, they will appear on the next screen. If you have no accounts set-up yet, click New on
the screen to give you an option to set-up a Clickatell or IntelliSMS account. You now need to sign-up for the service of your choice.

NOTE: You will need to be connected to the Internet to register for either of these services

IntelliSMS

To use IntelliSMS you need to sign-up for an account on the IntelliSMS website. Once you have your user details you simply enter your username, password and
the mobile number you used to register with the senice - which should ideally be the number you plan to use in your FrontlineSMS system - into the IntelliSMS
Account Configuration screen, below.

(S IntelliSms Account Configuration

& Account Username

7 Aeeount Password |

(]
& From Number [ [
[] 5% Use SSL
¥ Usa for sending
[ ] & Use for receiving

Lan

(s

If you want to also be able to receive text messages through the IntelliSMS senice - a helpful option if you don't have a phone or modem to attach to your computer -
you need to edit your "My Account -> Preferences" options on the IntelliSMS website, adding your email address and setting the Forwarding type to Email (see
below).
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To finish, you now need to tell FrontlineSMS you want to receive messages via the senice, and input your email account settings. You may need to consult your

email senice provider, or their website, to get some of this information, which needs to be added to the fields below in the IntelliSMS Account Configuration
screen. Tick the Use for receivingbox and enter your information (see example below).

TIP: It is recommended that you create a separate and dedicated email address for this service, and not use your personal email address.

B AccountUsemame | username

S heeount Paggmord | ===
1 Feeen Numbar
LS 550
) s for sensing
¥ BUse for recaking

B

& E-reail S4vE (2.0 OR SSNEL.EQM) DD gl eam
B & -mail Server Post (L]
¥ S E-mad U 551

T e

o E-muail Password ===

w5 | X Cancal

You should now be ready to go! If you have any problems, consult the Help pages on the IntelliSMS website.

NOTE: 'Connections' to live Clickatell or IntelliSMS accounts show in the Phones tab on a HTTP port.

Clickatell

To use Clickatell you need to set up your own Clickatell APl Account (select the HTTP/HTTPS option on the sign-up screen). Once you have registered for the senice
you need to input your username, API number, password and the mobile number you registered with Clickatell into the Clickatell Account Configuration screen

below. As soon as you have entered your details, assuming you remain connected to the Internet, you should see your Clickatell connection show as a HTTP
connection on the FrontlineSMS Phones screen

() Clickatell Account Gonfiguration

& AccountUsername |

-~ Account Password |

&> |Account AP |

I%From Mumber |
[] & use ssL
v/ ¥ Use for sending

| <« Save | | 2 Cancel |

5
.__“"“E

TIP: Messages can be sent out via Clickatell, but you can divert any replies to a local phone attached to your computer, and FrontlineSMS. If you insert a mobile
phone number in the Sender Number field, when users hit "Reply” on their phones, their message will come directly back to you, and not Clickatell. Please note
that all Sender Numbers need to be approved by Clickatell, who need to verify that the number belongs to you. Check out this Clickatell Help page for details.
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When using Clickatell you can also pass your organisation name along with the message, so it displays on the recipient's screen as, for example, "From:
FrontlineSMS". This might be helpful if there are issues of trust, and your recipient might be wary of the authenticity of a message coming from a number they don't
recognise. To do this you need to set an alphanumeric sender ID in Clickatell, who need to approve it first. Once approved you can type in the approved text in the
Sender Number field in FrontlineSMS (as above). Check out this Clickatell Help page for details.

NOTE: 'Connections'to live Clickatell or IntelliSMS accounts show in the Phones tab on a HTTP port

NOTE: You cannot set both a reply number and an alphanumeric name at the same time

Return to Help main menu
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Multimedia Messages (MMS)

From version 1.6.15, FrontlineSMS comes with a new Multimedia messages compatibility. In most countries, and for most mobile network operators, you can send
an MMS message from a phone to a standard email account. For now, FrontlineSMS can display the MMS received on these accounts (MMS sent to the connected
device are not supported yet). This help page will help you set up an E-mail account to allow FrontlineSMS to access the MMS received in your inbox.

Structure of an MMS

First of all, let's see what an actual MMS is.
An MMS (Multimedia Message Senice) is a type of message which extends the SMS capability. These are a way to send messages that include multimedia
content from phone to phone (and e-mail accounts). You can insert these kinds of content into a Multimedia message:

Text (like SMS)
Pictures
Videos

Sounds

e o o o

Configuring an MMS receiving e-mail account

In order to receive your MMS, you will need a working e-mail account, and the settings required to establish a connection. Then open the MMS Settings dialog, and
fill in all fields (see below).

E7{MMS e-mail Account Settings [x]

® (CIMAP (O EIPOP

@ Be aware messages with be deleted with the POP protocol. Click for help

3| Account Server |imap.gmai|.com | (e.g. pop.senver.com)

[ Account Server Port | 993 | (e.aPOP:110, POP SSL:842)
=i Account E-mail E i (e.0. account@server.com)
ZbAccount Password | | Y Use SSL

| " Save | | 2 Cancel |

You can access your account with either the IMAP or POP protocols. These are two ways of reaching your account, and some servers may not implement both
protocols. When using POP , your messages will be extracted from the server, and deleted. You can only access them once.

TIP: If you're not familiar with all of this or if you're not sure what you are doing, we strongly recommend a connection via the IMAP protocol.

Following the activity of your MMS e-mail accounts

On the Phones tab, you have access to all your communication senices. This includes every modem, Internet senice, and MMS e-mail account, connected or not.
You now have a better idea of the status of each senvice (see below).
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TIP: You can enable and disable MMS services at any moment by right-clicking on it and selecting Connect or Disconnect.

Return to Help main menu
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Troubleshooting

A few tips on helping get your phone or device connected and working with FrontlineSMS

File SeMings View Help
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Quick help

Before you dig any deeper into the FrontlineSMS troubleshooting section, check the following which may help you quickly resolve your problem

Handset
Are you using a Symbian phone (for example, a Nokia N-series phone), a Windows Mobile phone, a Blackberry or an iPhone? If you are, FrontlineSMS does not
currently support these generally higher-end devices. We plan to include support for these phones in future releases. Try and source an alternative phone

Cable

Are you using the correct cable for your phone? Many cables will fit phones they are not intended for, and using the wrong cable (or a cheap import) can cause your
computer to not recognise your device. Check your phone manufacturer's website for further information, or see if your phone and laptop supports Bluetooth, in
which case you will be able to connect without a cable

Driver

Have you installed a driver for your phone? Drivers tell your computer how to handle your phone. A missing driver, or a corrupt or invalid driver, will cause your
computer to either not properly recognise your phone or cause it to fail to properly connect. Check your phone manufacturer's website for further details or, if your
phone came with a CD, look there for installation instructions

Software

Some software programs which come on a CD with your phone block other applications, like FrontlineSMS, from accessing the phone. If you have installed Nokia
PC Suite, or any other phone management/handset management software from a CD, close this program and try running FrontlineSMS again. You may hawe to also
check that the program does not continue to run in the background - if it is you will usually see a small icon, usually towards the bottom right of your screen by the
clock on Windows machines. If you see one, right-click on the icon and select "Close" or "Exit" and try running FrontlineSMS again

If none of this works, check that your phone isn't on the Unsupported Phones section of the website
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My phone is plugged in but doesn't appear in either window

Make sure you have installed your phone driver. This might have come on a CD with your phone, or you can usually get it from your phone manufacturer's website. If
you can't find the driver there you can try a generic driver which may help. There's one available on the Prolific Technology website. If you have another programs
running on your computer which accesses your phone, this may 'lock’ it and make it unavailable to other programs such as FrontlineSMS. If you're running any other
software which might be doing this, close them and then try to connect again through the Auto Detect Phones button [3]

FrontlineSMS finds my phone but it shows in "Non-working" devices

This can happen if FrontlineSMS hasn't selected the correct "handler” to communicate with your phone. You can try to get your phone working by using the
Manually Connect button [4] which will allow you to manually choose different "handlers”. You may wish to ask your computer support person to help you with this,
since you may need some technical knowledge to complete these options

IQManuaII\r Connect
BlPort |

.'Baud Rate |

fHandler |-=de1’au|t=- v|

| « Connect || K cancel |

Port

This is the communications (COM) port which your computer assigns to your phone or modem when you plug it in (for example, COM1, COM2 and so on).
FrontlineSMS automatically searches through all your COM ports, but if for some reason it does not find your phone there, and you know which port it is connected
to, you can select it here

Baud Rate

This is the speed at which FrontlineSMS communicates with your phone or modem. Again, during the scan of your computer, FrontlineSMS tries talking to your
phone at different speeds. Once it ascertains the highest speed that your phone can work at, it fully connects with it at that speed. If for some reason FrontlineSMS
is unable to communicate at the right speed, your phone may not work. If you know the speed at which your phone communicates, you can select it here

Handler
FrontlineSMS uses "handlers” to talk with your phone. If it is unable to figure out what kind of phone you have, it may assign the wrong handler. To help alleviate this,
the Handler option allows you to manually select a handler, which you can then test and see if your phone works

¥ Manually Connect ]
ElPort | ] @
.'Baud Rate | |v|
7 Handler <default= -
=default=
Mokia_540_3ed
Samsung =

Siemens_M55
Siemens_MC78
Siemens_555
Siemens_TC35
SonyEricsson
SonyEricsson_GT48
SonyEricsson_W550i
Wavecom
Wavecom_M1306B

You may find that a Samsung handler works with a Nokia phone, or a Sony Ericsson handler with a Samsung, so it's worth experimenting:

<default>
This is the default handler, and you should try using this first for any phone you experience a problem with

Nokia_S40_3Ed
If you're having problems connecting your Nokia phone, try using this handler. Please note that this handler only allows you to send messages, not receive

SonyEricsson
This handler is used by most SonyEricsson phones

Samsung

Thin khandlav ~anb: Allaceia vimes ba ~amnd cmama~~an
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Once you've finished click on Connect. If it still doesn't work, try other settings or use a different phone

What if | still can't get my phone connected?

Because of the huge number of phones in the marketplace, FrontlineSMS is unable to support each and every one. Some phones are designed and built differently
to others, and in some cases these subtle differences will stop FrontlineSMS from successfully communicating. These differences can also exist in phones made by
the same manufacturer. For example, the Nokia 1100 uses different mobile-to-PC communications techniques to the Nokia 6100

If you want to check which phones we know work with FrontlineSMS, check out the Requirements page on the FrontlineSMS website. This list is not exhaustive and
some phones not listed will work, it's just that we've not been able to test them all. If you get a phone to work which is not on our list, please let us know through the
FrontlineSMS website Contact page and we'll let other users know. Thanks

If you'd like to find out about any other phone connection problems, check out the FrontlineSMS Community page. Check out the Discussion Forums in particular
and, if you like, post your own entry and ask for help

My phone is connected but will only send or receive messages - not both

Some phones are only supported in send or receive mode (these phones are categorised as "partially working" on the FrontlineSMS website Requirements page).
Your phone may be one of these "partially supported" devices. If so, there is nothing more you can do. However, it is possible that you have simply configured your
phone to only be used to send, or to receive, in the phone's Settings menu. Settings for phones and modems listed in the Working devices window [1] can be
changed through their "Settings" menu. To access this menu, right-click your mouse on the phone or modem in the list and select View/Edit Device Details from
the menu. The following screen will appear:
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Please note: If FrontlineSMS knows that your phone is "partially working", i.e. unable to send, or unable to receive, some of the options above will be deactivated

Don't use this phone
If this phone is connected to your computer for another use, and you don't want FrontlineSMS to touch it, select Don't use this phone and click Save

Use for sending
If you want this phone to appear in the Phones tab and be available to send text messages, tick this box

Use delivery reports
If the phone has been selected to Use for sending, tick the Use delivery reports if you want FrontlineSMS to check if messages have been successfully delivered
(please note that not all networks operators support delivery confirmations)

Use for receiving
If you want FrontlineSMS to monitor this phone and download incoming messages, tick this box

Delete messages from phone, after receiving
If the phone has been selected to Use for receiving and you'd like FrontlineSMS to leave messages on the phone once they are downloaded and read, leave this box
unticked. Tick this box if you want them removed

Once you have finished setting up your phone, click on Save. If you change your mind, click on Cancel. These settings can be changed at any time by returning to
the Phones module and repeating these instructions
I'm using a Clickatell or IntelliSMS account and my messages won't send, or AutoReply won't work

If you're using Clickatell or IntelliSMS to send your messages, in FrontlineSMS your numbers need to be saved in international format, i.e. they must start with
00<country code><number> or #<country code><number>. You may need to go back and edit the numbers in your Groups to correct this. If you're using Clickatell

or IntelliSMS and are having problems with the AutoReply functionality in FrontlineSMS, check out the Settings menu for a possible cause and solution

I've edited my Database Settings and now FrontlineSMS won't start

If, for some reason, you've needed to edit your Database Settings and you now find that FrontlineSMS won't start, you can manually edit them in the FrontlineSMS
Properties Directory. The location of this Directory varies depending on your operating system
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NOTE: You can check the location of your system files by clicking on Show Configuration Location in the Help menu in FrontlineSMS

Once you find the Properties Directory, you can manually edit your database settings in the database.properties and mysql.properties files (if you're using the
default MySQL database in FrontlineSMS). If this sounds too much like hard work, just delete the whole properties directory and the next time FrontlineSMS starts it
will revert to the original default settings

What if I'm still having problems?
If FrontlineSMS has previously worked but doesn't any longer:

Have you changed the device, or are you using a different cable, or plugged it into a different socket/port, or have you installed some new software? One of these
may have caused the problem, so track back and see what might have changed. Or, sometimes if a device is left attached and running for a long period of time, it
can hang or 'drop out'. If this happens, or you think it may have happened, unplug your phone or modem, shut down FrontlineSMS, restart your computer, reattach
your phone or modem, and then restart FrontlineSMS. In most cases this will correct the problem. If it does, try to shut down FrontlineSMS each evening before you
leawve, if it's not needed (to awoid the problem happening again). Don't worry - it will pick up any messages that are sent overnight as soon as you start it up again

If FrontlineSMS still refuses to connect to the phone or modem:

Sometimes other programs running on your computer can block FrontlineSMS, stopping it from seeing your phone or modem. These programs often 'lock' the
device, which stops anything else from using it (not just our software!). If you are running software which came with your phone or modem (such as Nokia Handset
Manager), close the program (and make sure it's not running in the background, where it will be visible in your System Tray, near the clock on your screen). Once
you have closed the program, reconnect your device, restart FrontlineSMS and see if the software can find it

If none of this works:

If you can't find the answer in any of the FrontlineSMS Help screens, the FrontlineSMS Community may be able to help. If you are having problems connecting

devices then try speaking to your computer support person, who may be able to help determine if you're having driver or cable problems. If you have time to send log
files for us to look at, please follow the procedure below

FrontlineSMS log files

We're constantly looking to improve FrontlineSMS. If you're experiencing any problems we'd love to hear from you. The easiest way for us to analyse problems is to
look at the "log files" which are generated while you use FrontlineSMS. If you are connected to the Internet, you can submit your log files automatically to the
FrontlineSMS Support Team by selecting Submit Error Report from the Help menu. Please then post an entry in the online forum, and we'll get back to you from
there

Return to Help main menu
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